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1 Introduction 

 

The purpose of this document is to allow users to quickly access information concerning a particular point of interest in 
the Programmer Editor. 

The Programmer Editor is a Windows based tool that lets you create single channel or multiple channel setpoint 
programs (Profiles) for LIN instruments. 

This editor enables a customer to create and edit programs stored on the local machine. It outputs a complete setpoint 
program as a binary file within the constraints defined in the Program Template file, ready for direct downloading to the 
target instrument. 
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2 What is Setpoint Programming ? 

Setpoint Programming is the control configuration of a selected instrument output value (channel), typically a setpoint 
(SP), over a specified period of time. 

The Setpoint Program information is generated by this editor and held in a Program file (.uyy). The Program file is 
produced from a previously configured template defined in a Program Template file (.uyw). This Program Template file 
is created using the Programmer Wizard available from the Tools menu in LINtools. 

 

The Program Template file defines a suite of blocks that includes the PROGCTRL block, PROGCHAN and SEGMENT 
blocks, held in a PROG_WIZ compound. These blocks provide access to all parameters in the Setpoint Program that 
are used to configure the values in the Program file and control the Profile of the Setpoint, Events and User Values in 
the instrument. 

What is a Setpoint ? 

Setpoint is the target value that an automatic control system, e.g. PID controller, will aim to reach. For example, a boiler 
control system might have a temperature setpoint that is a temperature that the control system aims to meet. 
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Setpoint Programming - Overview 

The purpose of a Setpoint Program is to control and manage the target value that an automatic control system, e.g. PID 
controller, will aim to reach. For example, a boiler control system might have a temperature Setpoint, i.e. a temperature 
the control system aims to attain in the system. 

The Setpoint Program is a set of defined values for a Single Channel Program or a Multi-Channel Program stored in a 
Program file (.uyy). A Program file is generated using this editor within the specification defined in a Program Template 
file (.uyw), generated using the Programmer Wizard. 

Remember 

Editors can be launched using the appropriate command available from the Tools menu in LINtools. 

To create a Program, a Program Template must first be produced using the Programmer Wizard in LINtools. The 
resulting Program Template file can then be used by this editor to create the Setpoint Program. The Programmer 
Wizard creates blocks that can only control Programs produced using this editor. 

Remember 

Use the Programmer Wizard in LINtools to generate or edit a Program Template file and create the PROG_WIZ 
compound. Make sure the required input values and output values to/from the plant/system are wired to the block in this 

compound. 

1 Launch this editor by, 

 Selecting  Start > Programs > ... > Programmer Editor > Programmer Editor, or 

Note 

'...' denotes the default installation path. 

 in LINtools open the PROG_WIZ compound, and the PROGCTRL block to show the Object Properties pane. 
Enter a name in the ProgFile field, and select the Open Program file (.UYY) command from the context 

menu. If the file already exists the Program file opens in this Editor, but if it does not the Program file is created 
after pressing Yes to confirm that a new file is required, or 

 alternatively, select Tools > Programmer Editor from LINtools. 

Then, select the Open command to open an existing Program file, or the New command to create a Program file. If 
creating a new Program file, select the Program Template file used to define the properties of the Program. This must 
from the location specified in the Programmer Wizard. A Program file is opened and displays up to 3 Profiled Channels 
with any remaining channels being selectable. 

2 Configure a Program. This will produce a pattern of control for each Profiled Channel, and show how the setpoint is 
controlled through the Program. 

3 Control a Program. This will allow the user to control the Program currently running in the instrument after the 
Online Connect command is pressed. 
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Multi-Channel Program 

A Multi-Channel Program is suitable for applications that require more than one Setpoint to be profiled, e.g. 
environmental chambers that control temperature and humidity. 

The Program type is pre-defined in a Program Template file that is generated by the Programmer Wizard in LINtools. A 
Multi-Channel Program creates a Profile for each Channel Name defined in the Programmer Wizard. 

Exit conditions can only be configured to occur in segments that are not ramping the setpoint, i.e. Dwell and Step. All 
Profiled Channels must be Step or Dwell segments in order to meet this condition, see Seg03 below. 
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Single Channel Program 

A Single Channel Program is suitable for applications that require a single Setpoint to be profiled, e.g. heat treatment or 
firing ceramics materials. 

The Program type is pre-defined in a Program Template file that is generated by the Programmer Wizard in LINtools. A 
Single Channel Program creates a single Profile for the Channel Name defined in the Programmer Wizard. 

 

What is a Program Template file ? 

This file is used to define a template for the number of channels and segments available to the Program in this 
instrument. It contains the information generated from the Programmer Wizard that creates a pre-configured a suite of 
blocks that includes the PROGCTRL block, PROGCHAN blocks and SEGMENT blocks, held in the PROG_WIZ 
compound. 

Note 

The compound will automatically layout the blocks in a logical order. 

The blocks in the compound provide access to all parameters in the Setpoint Program that are used to control the 
operation of the Setpoint in the instrument. 

Note 

The Program Template file is automatically downloaded to the instrument along with the database. 

What is a Program file ? 

This file holds the Program information used to control a one or more instrument output values (channels) over a 
specified period of time. It is generated by this Editor and is based on a Program Template file, generated using the 
Programmer Wizard available from the Tools menu in LINtools. 

Note 

The Program file is automatically downloaded to the instrument along with the database. 
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What is LIN? 

Local Instrument Network or LIN is a communications protocol providing a token-passing masterless Network which 
allows peer-to-peer communications and file transfer between instruments. It is supported via Ethernet, Arcnet and 
Serial communications connections. 

A LIN Database groups data into blocks of related data. For example, a function block can represent an input, an 
output, a controller, and so on. The LIN configuration tool (LINtools) and display packages (i.e. User Screen Editor) 
recognise different types of function block, and handle them appropriately. 

Communications between LIN and Modbus instruments require a Gateway. This is an interface between the LIN 
communications protocol and the Serial communications protocol, generally provided by blocks in the database. It 
involves the mapping of data from the LIN Database to the Modbus registers and digitals. 

What is a LIN Database ? 

A LIN Database (.dbf) is a database that runs in a LIN instrument providing data and rules, also known as a 'Strategy'. 

It is loaded by the LIN Instrument at runtime and allows the instrument software to control and monitor signals from 
sensors in the plant/system, e.g. an industrial plant, and then output the signals back to actuators. 

The cycle of signal input, signal processing, and signal output to the entity is repeated continuously while the database 
is run in the instrument. 

More than one LIN instrument can be involved in controlling a single entity, but only one LIN Database can run in a 
single LIN instrument at a time. 

A LIN Database can be configured as a standard LIN Database or blended LIN Database, both operating in conjunction 
with one or more LIN Sequences running in the LIN instrument. It can also make use of LIN Actions stored in action 
files in the LIN instrument. 

In LINtools, a LIN Database is represented and configured graphically as an arrangement of connected LIN function 
blocks, where input to output links, are represented as wires between blocks. 

What is a LIN function block ? 

LINtools uses a block-structured approach to configuring a control strategy, where a variety of ready-made function 
blocks perform the processing required. Any strategy can use a combination of LIN block, Control Module block and 

Application block to create a strategy suitable for the instrument. 

A function block is an instance of a reusable module of program code, called a template, dedicated to a particular type 
of processing operation - e.g. the ADD2 template adds two numbers. In general, function blocks take in analogue 
and/or digital signals via their inputs, process them in a variety of ways, and then pass the results on via their outputs. 
You ’r;wire’ the function blocks together so that the signals can flow between them to execute the control strategy. 

Note 

For ease of use, some blocks divide the fields into pages. Fields in blocks with paged parameters are referenced using a 
block.page.field.subfield. 
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3 Menus 

Menus 

This section provides a summary of the functions of all toolbar buttons and menus displayed in the Programmer Editor. 

It is intended to be a quick reference to support particular button or menu item functions. 

Note 

A 'tooltip' will appear when first locating the cursor over a toolbutton. 

The Menus can be divided into command and information areas. 

Menu bar 

The Menu Bar is a special toolbar that contains the pulldown commands. Each pulldown displays a further list of 
commands. 

The Menu bar contains the following items, 

 

 Click menu to get help! 

Toolbars 

The Toolbars contain buttons that enable quick access to a number of commands used to configure the Program file. 

 Toolbar 

The Toolbar hosts icon buttons that enable quick access to a limited number of File commands. 

 

 Click Toolbutton to get help! 

 Monitor Toolbar 

The Monitor Toolbars contain buttons that enable quick access to a number of commands used to control the Program. 

 

 Click Toolbutton to get help! 

Status bar 

The Status Bar displays setpoint limits associated with the Profiled Channel. It is displayed along the foot of the screen. 

 

 Click message to get help! 
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File menu 

The File menu enables the control of an individual Program application file using the following commands. 

 

 Click command to get help! 

New Program file command 

 

<Ctrl> + <N> 

Click this to launch the Choose a Program Template File dialog. This permits the user to browse and open a specific 

Program Template file from the dialog displayed. 

Open Program file command 

 

<Ctrl> + <O> 

Click this to display the Open dialog. This permits the user to browse and open a Program file from the dialog 

displayed. 

Save command 

 

<Ctrl> + <S> 

Click this to display the Save dialog. Click this to automatically save the active file with its current file name, location, 

and file format. 

Save As Program file command 

Click this to display the Save As dialog. This permits the user to save the current Program file with a different filename 

and/or location. 

Close command 

Use this to terminate the current Program file. If any unsaved changes exist, the user can cancel this command, save or 
discard the changes, and then repeat this command. 

Exit command 

Click this to close this editor. If any unsaved changes exist, the user can cancel this command, save or discard the 
changes, and then repeat this command. 

Open Recent Program files command 

Click this to open one of the most recently saved Program files in this window. 



Programmer Editor User Guide 

Programmer Editor User Guide HA 029 850 
Page 12  Issue 2, Oct 11 

Edit menu 

The Edit menu provides commands used to manipulate an individual 
Program file. 

 Click command to get help! 

Undo command 

 

<Ctrl> + <Z> 

Click this to reverse the last command. 

All operations can be undone back to the last saved version by clicking this 
button (or <Ctrl+Z>). Click the adjacent redo button to restore the undone 

operations. 

Redo command 

 

<Ctrl> + <Y> 

Click this to reverse the action of the Undo command. 

All operations can be redone by clicking this button. Click the adjacent undo button to undo actions that have been 
redone. 

Cut command 

 

<Ctrl> + <X> 

Click this to remove the selected segments and place them on the Clipboard. 

Copy command 

 

<Ctrl> + <C> 

Click this to copy the selected segments and place it on the Clipboard. 

Paste Over command 

 

<Ctrl> + <V> 

Click this to overwrite the selected Segment with the contents of the Clipboard. This command is available only if you 
have cut or copied an object, text, or contents of a cell. The number of segments selected in the Segment grid must 
correspond to the number of segments that were cut/copied to the clipboard. 

Paste Insert command 

 

Click this to insert the Segments on the clipboard after the selected segment. This command is available only if you 
have already cut or copied a segment. 

Select All command 

Click this to select all the segments displayed in the Segment pane. 
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Segment menu 

The Segment menu contains entries for inserting and deleting segments. 

 

 Click command to get help! 

Insert Segment command 

 

Use this to add a new segment with a default configuration that will not impact the Program. This will appear before the 
selected segment with a default name, e.g. "3", duration, and profile command, ready to be configured. 

The information configured in the segment will appear on the corresponding Segment page of the appropriate 
SEGMENT block in LINtools when connected to the instrument. 

Delete Segment command 

 

Use this to delete the selected segment. This will remove the configured segment from the Program. 
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Graph menu 

The Graph menu offers a commands that control the display of the plots. 

 

 Click command to get help! 

Restore Zoom command 

 

Use this to restore the default display of the Chart pane after using the zoom feature. 

Tip! 

You can Zoom in to a specific section of the Chart pane by dragging the left mouse button to select a length of time from 
left to right, and Zoom out using the same button in the opposite direction to return to the default Chart pane display. The 

right mouse button can be dragged to change the time period shown in the zoom. 

Plot using Limits command 

This is used to configure the limits of the display for the plots in the Chart pane. 

When enabled each plot in the Chart pane will extend to the limits configured in the Programmer Wizard. However, 0 
(zero) will always be included in the plot, i.e. a plot will always extend from 0 (zero) Deg.C to 1200 Deg.C if the 
Programmer Wizard limits are configured as 10 Deg.C to 1200 Deg.C. 

When disabled each plot will be displayed will extend to the specific limits configured in the Programmer Wizard, i.e. a 
plot will extend from 10 (zero) Deg.C to 1200 Deg.C if the Programmer Wizard limits are configured as 10 Deg.C to 
1200 Deg.C 

This setting is retained when the Programmer Editor is closed. 

Programmer Wizard 
Plot 

using limits 

Profiled Channel Plot (Y-axis) 

Low Limit High Limit Low Limit High Limit Low Limit High Limit 

-10.000 1500.000  -2.500 1235.000 -2.500 1235.000 

-10.000 1500.000  -2.500 1235.000 -10.000 1500.000 

0.000 1500.000  0.000 1235.000 0.000 1235.000 

0.000 1500.000  0.000 1235.000 0.000 1500.000 

+10.000 1500.000  +12.500 1235.000 +10.000 1235.000 

+10.000 1500.000  +12.500 1235.000 0.000 1500.000 
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Online menu 

The Online menu offers a command that provides a connection to the instrument. 

 

 Click command to get help! 

Online Connect command 

 

Click this to attach to the instrument where one or more Programs can run, corresponding to the database associated 
with this Program file. 

A dialog will appear if more than one PROGCTRL block is compatible with the current Program Template file. This 
dialog will allow you to select the required Programmer blocks in the instrument. 

Help menu 

The Help menu enables the user to display details about this editor using the following commands. It is divided into 2 
sections. 

 Documentation (including Contents, Index, and Search for Help on) 

 Editor (About) 

Any of the first 3 options opens the on-line help documentation with the selected as the priority command. 

 

 Click command to get help! 

Help Topics command 

Click this to open the help documentation. 

 Select Contents to open the ’Help’ file, displaying the ’Contents’ page as the priority. 

 Select Index to open the ’Help’ file, displaying the ’Index’ page as the priority. 

 Select Search to open the ’Help’ file, displaying the ’Search’ page as the priority. 

Help browse buttons 

 

In the Help file, click the Back and Forward browse buttons to move from one topic to the next, or previous in a 

logical order. 

The Previous and Next buttons can be used to browse between topics in a particular sequence. 

About command 

Click this to display a dialog, showing the software version number. 
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4 Program File Window 

Program File Window 

The window is normally divided into three resizeable panes, 

 the chart pane 

 the program properties pane 

 the segment grid 

The Chart pane and Segment grid present an alternative view drawn from the same file data. The Program Properties 
pane provides parameters used to configure the operation of the Program, Channel and each segment as it is 
executed. 

You can alter the relative sizes of the panes, and select various parts of the Program file in the different panes, to make 
the views clearer, or to edit the highlighted objects. 
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What is the Chart pane ? 

Chart pane - Offline 

The Chart pane displays the setpoint program as one or more plots. In the example below, three analogue setpoints 
('My_PV01', 'My_PV02', 'My_PV03') are charted. It can display up to 3 Profiled Channels. The upper two Charts always 
show the first two Profiled Channels configured using the Programmer Wizard, but the lowest of the three Charts can 
be used to display any other configured Profiled Channel, Digital Event or User Value when selected in the Program 
Properties pane or the Segment pane. 

Each Chart shows one Profiled Channel and a selected Segment, indicated by the heavy bar displayed on the Low 
Limit line. If a Go Back sequence is configured, the heavy bar appears on each occurrence of the segment as specified 
by the Go Back Cycles field on the Segment page of the Program Properties pane, i.e. the heavy bar is shown 3 times 
if the Go Back Cycles is 2, two occurrences as part of the Go Back Sequence plus the initial occurrence of the 
segment. 

 

The Y-axis on the chart displays analogue setpoint units as configured in the Programmer Wizard in LINtools. The X-
axis on the chart shows the start of each segment, i.e. Seg01 is configured to take 24 minutes to Ramp to the 
configured setpoint and the whole Program will last 6 hours and 55 minutes. 

Tip! 
You can Zoom in to a specific section of the Chart pane by dragging the left mouse button to select a length of time from 
left to right, and Zoom out using the same button in the opposite direction to return to the default Chart pane display. The 

right mouse button can be dragged to change the time period shown in the zoom. 
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Chart pane - Online 

After pressing the Online Connect command and connecting to the instrument, the Chart pane displays the running 
Program. A moving vertical bar, initially positioned at the left side of the plot, is used to indicate the current progress of 
the Program when it is running. 

 

Pane Separator 

 

This separator can be used to reduce the size of the Program Properties pane. Manually drag the solid bar to reduce 
the size, or press the button to completely collapse or expand the Program Properties pane as appropriate. 

What is the Program Properties pane ? 

The Program Properties pane is used to set Program and Channel properties as well as individual Segment 
parameters. 

Note 

The Program Properties pane can be minimised by pressing the button in the centre of the pane separator, or manually 
reduced by dragging the separator. 
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The Program tab of this pane provides overall Program parameter configuration. 

Program Name 

Used to identify a Program. 

Note 

The Program Name may not necessarily be the same as the Filename. 

Read Only 

This is used to configure the read/write permissions of the Program 
file after it has been downloaded to the instrument. 

 TRUE provides write protection to the file. 

Cycles 

Used to define the number (1 - 999) of times the Program will run. Using 0 will cause the Program to repeat 
continuously. 

PV Start 

This is used to configure the starting point of the Program. This allows the Program to automatically advance to a point 
in a Profile corresponding to the current PV. 

 Off will start the Program at the starting point of the first Segment 

 Rising will start the Program at the first rising Segment equal to the current PV value 

 Falling will start the Program at the first falling Segment equal to the current PV value 

Rate Units 

This is used to configure the time unit (Seconds/Minutes/Hours/Days) applied, by default, to all RampRate segment 
types in the Program. 

End Condition 

This is used to configure the action taken when the last Segment (END segment) in a Program has completed if Cycles 
is configured to a value more than 0 (zero). 

 Reset will automatically return to the Idle state when the Program has completed. 

 Dwell will control the PV at the current value constantly until the Program is reset using the Reset button. 

Algorithm File 

This is used to define the Algorithm file used in the Program. An Algorithm file contains data values that are written to 
the Algorithm block when the Program is loaded, i.e. recipe values. 

Note 

This file is loaded via the AlgBlk field in the PROGCTRL block in the database. 

Filename 

This shows the location and name of the .Program file which is currently open. 

Note 

The Filename may not necessarily be the same as the Program Name. 

Remember 
Both Program Template file and Program file must be at the location defined here. 

Template Name 

This shows the Program Template file used to define the template for the Program file shown in Filename. 
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The Channels tab of this pane provides parameter configuration for each Channel in the Program. 

 

Channel Name 

This shows the name used to identify the Profiled Channel. 

This is the Name on the Profiled Channels page of the Programmer Wizard launched from LINtools. 

Servo 

Used to determine the starting point of the Program. 

 PV will start the Program from the current PV value in conjunction with PVStart field on the Program page. 

 SP will start the Program from the current SP value. This configuration will be ignored if PVStart is set to Rising or 
Falling. 

Holdback + Alarm Mode 

This is used to configure the application of the Holdback operation in the Program. 

 Off will disable the Holdback operation in the Program. 

 Per Channel will apply the Holdback value to all Segments in the channel. 

 Per Segment will apply the Holdback value given in each individual Segment. When Per Segment is selected the 
Holdback and Alarm Value is configured on the Segment tab. 

Holdback and Alarm Value 

This is used to configure the deviation threshold value between SP and PV that is used to stop the Setpoint ramp when 
the PV is unable to react to the changing Setpoint. 

 When Per Channel is selected this value is configured on the Channel tab. 

 When Per Segment is selected this value is configured on the Segment tab. 

Units 

Used to show the units of this Profiled Channel, i.e. Eng (Engineering Units), Deg.C, Deg.F, K or R. These units appear 
along the Y-axis of each Profiled Channel. 
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The Segment tab of the this pane provides Segment parameter configuration 

Note 

All parameters are read only when connected to the instrument. 

Segment Name 

This is the name used to identify the selected segment. 

A name of up to 16 characters in length can be entered on 
the Segment tab of the Program Properties pane and is 
shown at the top of the corresponding Segment in the 
Segment pane. 

Go Back To 

This is used to configure the next non-sequential Segment 
that will be executed when this current Segment is 
complete. This will be the name of the first Segment in a 
Go Back Sequence. 

The segment initiating the Go Back sequence is 
considered as the last segment in the sequence. This 
allows the segments to be repeated the number of times 
specified in Go Back Cycles. If there are multiple Go Back 
Sequences they cannot jump back over a previous Go 
Back Sequence. 

Note 

Select 'Don't go back' to remove the Go Back Sequence. 

Go Back Cycles 

This is used to configure the total number of times the Go 
Back Sequence will be executed. 

Holdback Type 

This is used to configure the type of Holdback used to 
assert the corresponding alarm and initiate the configured 
Holdback operation. 

 None will disable the application of a Holdback action 
in this Segment. 

 Low will trigger the Holdback action when the 
measured PV is below the SP by more than the 
Holdback value. 

 High will trigger the Holdback action when the 
measured PV exceeds the SP by more than the 
Holdback value. 

 Band will trigger the Holdback action when the 
measured PV is either below (Low) or exceeds (High) 
the SP by more than the Holdback value. 
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Deviation Alarm 

This is used to configure the how the deviation alarm will be asserted. 

 None will disable the Deviation alarm in this Segment. 

 Low will trigger the Deviation alarm when the measured PV is below the SP by more than the Holdback value. 

 High will trigger the Deviation alarm when the measured PV exceeds the SP by more than the Holdback value. 

 Band will trigger the Deviation alarm when the measured PV is either below (Low) or exceeds (High) the SP by 
more than the Holdback value. 

Note 

To display a deviation alarm, the corresponding Alarm Priority value must be configured in the database. 

Out Of Bounds (OOB) Alarm 

This is used to configure the how the OOB (Out Of Bounds) alarm will be asserted. 

 None will disable the OOB alarm in this Segment. 

 Low will trigger the OOB alarm when the measured PV is below the SP by more than the Holdback value. 

 High will trigger the OOB alarm when the measured PV exceeds the SP by more than the Holdback value. 

 Band will trigger the OOB alarm when the measured PV is either below (Low) or exceeds (High) the SP by more 
than the Holdback value. 

Note 

To display a Out Of Bounds alarm (PROGCTRL.File.Alarms.Oob), the corresponding Alarm Priority value must be 
configured in the database. 

Alarm Delay 

This is used to configure the delay in time, up to 12 hours, between detecting and asserting the alarm condition. The 
delay period is configured via the Alarm Delay dialog and provides a filter for nuisance alarm conditions. 

Events 

This is used to set the On/Off states of 0 (zero) or more Digital Events for the duration of the selected segment. 

Each Digital Event name and enumeration is defined in the Program Template file. 

Wait/Exit conditions 

This is used to configure the operation of the Program when the segment has executed. 

Each segment shows a list of 0 (zero) or more Wait condition names, Exit condition names and the corresponding 
enumeration values indicating 3 different states (No Wait/No Exit, Off or user configured enumeration, and On or user 
configured enumeration) of an input value. All the values are defined in the Program Template file. 

Note 

Exit conditions can only be applied to segments that do not contain ramping control of the setpoint. 

User Values 

This is used to write the configured user defined value to an appropriate output, typically an AO_UIO block, when the 
segment has executed. 

Each segment shows a list of 0 (zero) or more User Value names and the corresponding general purpose analogue 
values that will be written. The User Value name, Low and High limits, and Decimal place notation are defined in the 
Program Template file. 
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What is the Segment grid ? 

The Segment grid shows each of the segments in the order of execution from left to right. The maximum number of 
segments is defined in the Program Template file selected when creating the Program file. 

Note 

After Online Connect is pressed, this grid is displayed on a tab in read-only form and is accompanied by a Status tab. 

When configuring a Multi-Channel Program the Name, Duration, Type and Setpoint value are displayed as grid rows for 
each channel. If configuring a Single Channel Program then a Rate/(units) row is also displayed. All other segment 
configuration parameters are available on the Segment page of the Program Properties pane. 

Note 

Each segment corresponds to a single page of a SEGMENT block in the database. 

 

Segments are inserted before the selected segment using the Insert Segment command. Each Segment is inserted 
with a default configuration that will not impact the Program. 

The final segment in the Program is always the END segment. This is a read only segment that signify one cycle of the 
Program has completed. 

Note 

When connected to the instrument the current segment is highlighted as it starts. 

Segment Name 

This is the name used to identify the selected segment. 

A name of up to 16 characters in length can be entered on the Segment tab of the Program Properties pane and is 
shown at the top of the corresponding Segment in the Segment pane. 

Duration 

This is used to configure the time taken (dd,hh:mm:ss) for the measured PV to attain the setpoint configured in the 
Setpoint field using the control specified in the Channel field. 

Tip! 

Adding a duration to a Step segment will cause a dwell at the target setpoint for the configured time period. 
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Name 

This shows a name identifying an individual Profiled Channel as defined in the Program Template file. 

Note 

A Profiled Channel is the pattern of control for a single setpoint value. 

Setpoint 

This is used to configure the Target Setpoint. 

Note 

If the next segment does not start as expected, Wait conditions may have been configured and have not been satisfied. 

The value is displayed using the decimal place notation corresponding to the Channel Name as specified in the 
Program Template file. 

Segment Type 

This is used to configure the type of setpoint control executed in this segment. 

 STEP ( ) will change the operating setpoint to the configured Target Setpoint value at the start of the Segment. 

 DWELL ( ) will inherit the setpoint from the previous Segment and retain it at that value for a specified period. 

 RAMPTIME ( ) will ramp the operating setpoint to a defined Target Setpoint value over a specified time period. 

 RAMPRATE ( ) will ramp the operating setpoint at a desired rate of change until a defined Target Setpoint value 
is obtained. 

Note 

RAMPRATE is only available for a single channel Setpoint Program. 

 END is read only and signifies the last Segment of the channel. 
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What is the Status tab ? 

The Status tab provides the current status of the running Program when this editor has attached to the instrument after 
pressing the Online Connect command. 

Note 

Only displayed when connected to the instrument. All buttons enabled for clarity. 

 

It is divided in to 4 areas, 

 Current status 

This area displays the current status of the Program, e.g. Program: Loading (00:00:00 remaining) (corresponding to 
the PROGCTRL.Monitor.StateFlg), Segment: Seg01 (00:00:00 remaining) (corresponding to the name of the current 
segment in operation as highlighted on the Segment tab), Program Cycle: 1 of 2 (corresponding to the number of 
times the Program has run), and GoBack Cycle: 2 (corresponding to the number of times the Go Back Sequence has 

run). It is colour coded in conjunction with the Program state, i.e. Idle is Grey, Running is Green, Hold is Amber and 
Complete is Cyan. 

 Channel Setpoints 

This area displays the information about each of the Profiled Channels, including the Segment Type as indicated by the 
icon, the name of the Profiled Channel, according to the name entered in the Programmer Wizard in LINtools, and the 
Target Setpoint for the current segment in the units configured in the Programmer Wizard. 

Note 

Selecting a Profiled Channel in this area will change the focus in the Chart pane, and will also change what is displayed in 
the lowest of the three plots. 

 Program History 

This area displays a list of changes applied to the segment as it is initiated and a record of operations applied to the 
Program at runtime, including date and time references and is cleared each time a Program is started. 

The Save History button used to save the list of actions applied to the currently operating Program as a text file (.txt). 

 Program Control 

This area offers buttons that control a Program at runtime. Each button corresponds to a 
PROGCTRL.Monitor.Command subfield in the database. 

Save History button 

 

Used to save the list of actions applied to the currently operating Program as a text file (.txt). 

The text file can be used to review how the Program was run. 
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5 How to... 

Configure a Program 

Each Program configuration is determined by the Program Template file configured using the Programmer Wizard in 
LINtools. 

Configure the parameters in the Segment grid to determine the setpoint control, and the parameters in the Program 
Properties pane to determine the operation of the Program as each Segment is executed. 

1 Configure the Program parameters. Configuring values for the parameters on the Program tab of the 
Program Properties pane will define the properties of the Program. 

 Select the read/write permission of the Program file in the Read Only parameter. This controls write access to 
the Program file when it is in the instrument. 

 Enter the number of cycles the Program must run in the Cycles parameter. This is the number of times the 
Program is repeated. 

 Select the starting control for the Program in the PV Start parameter. This controls the starting point of the 
Program in conjunction with the Servo parameter on the Channel page. If not set to OFF it will automatically 
advance to a point in the Profile corresponding to the current PV and start the Program. 

 Select the action when the Program is complete in the End Condition parameter. This is the action applied 
when the last cycle of the Program is complete. 

 Enter the algorithm file name in the Algorithm File parameter. The algorithm file contains values that are 
written to the Algorithm block when the Program is loaded. 

 Filename and Template Name parameters are read-only and display the location of the Program file and the 
Program Template file relating to the open file, respectively. 

2 Configure the Channel parameters. Configuring values for each Channel parameter on the Channel tab of the 
Program Properties pane will define the operation of the Channel when started. 

 Select the starting point operation of the Program in the Servo parameter. This controls the starting point of the 
Program in conjunction with the PV Start parameter on the Program Properties page. It will automatically 
advance and start the Program from the initial setpoint or the current PV accordingly. 

 Select the Holdback mode, and enter the HbVal. This is how the Holdback action will be applied when the 
measured PV deviates from the SP by more than a configured amount, according to the configured the 
Holdback Type. 

 Units parameter is read-only and displays the value configured in the Programmer Wizard. 

3 Configure a Segment. Configuring values for the parameters below will create a pattern of control for each Profiled 
Channel, and show how the setpoint is controlled through the Program. 

 Enter the duration of the segment. This applies across all Profiled Channels, but is disabled when RampRate 
is selected as the segment type in a Single Channel Program. 

 Select the Segment type from the list. The Segment type determines how the current setpoint is driven to the 
specified Target Setpoint. 

 Enter the Target Setpoint. This is the value of setpoint which the measured PV of the control loop is aiming to 
reach. 

 Enter the Rate/(Units) (Single Channel Programs only). This is the rate at which the setpoint will ramp to the 
Target Setpoint in units specified in the RateUnits parameter on the Program page of the Program Properties 
pane. 
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4 Configure the Segment parameters. Configuring values for each Segment parameter on the Segment page of the 
Program Properties pane will define the operation of the Segment when executed. 

 Enter the Name for the selected Segment. This will simplify the identification of the Segment currently being 
executed. 

 Select the Segment to go back to in the Go Back To parameter to identify the first Segment in a Go Back 
sequence, and enter the number of times this Go Back sequence must be executed in the Go Back Cycles 
parameter. 

 Select the type of Holdback in the Holdback Type parameter that will cause Holdback to occur. This 
determines that Holdback will occur when a measured PV deviates from the SP in the defined direction by 
more than a configured amount. 

 Select the type of deviation alarm in the Deviation Alarm parameter that will be asserted if PV deviates from 
the SP in the defined direction by more than a configured amount. 

 Select the type of boundary alarm in the OOB Alarm parameter that will be asserted if PV deviates from the SP 
in the defined direction by more than a configured amount. 

 Enter the time delay period in the Alarm Delay parameter that will be applied when an alarm condition is 
detected. This provides a filter for nuisance alarm conditions. 

 Enable the required digital events in the corresponding Event parameter. This will write the event state when 
the Segment is executed. 

 Select the condition state used to prevent the Program proceeding to the next segment until a specific 
configuration is met when the Segment is executed in the corresponding Wait Conditions parameter. 

 Select the condition state used to cancel the Program if a defined state has occurred when the Segment is 
executed in the corresponding Wait Conditions parameter. 

 Enter the general purpose analogue values that will be selected when the Segment is executed. 
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Configure a Segment 

Each Segment in a Program defines a specific operation to the setpoint requiring a defined target setpoint, the value of 
setpoint at which the measured PV of the control loop is aiming, the type of control used to attain this value, and the 
time period for that segment. 

Note 

Single Channel Programs include the Rate parameter for each segment. 

To configure a segment 

1 Insert the appropriate number of segments using the Insert Segment command. Each Segment is 
inserted with a default configuration that will not impact the Program. Any Segments that are not used can be 
deleted later using the Delete Segment command. The number of segment columns in the Segment pane 
increases as each segment is inserted. 

 

2 In the Segment pane, select the required segment. The selected Segment is indicated by the heavy bar displayed 
on the Low Limit line of the Chart. 

 Edit the duration of the selected segment to define the time taken for the current setpoint to attain the next 
Target Setpoint by entering the total number of hours, minutes and seconds as a numerical string. 

To define a period that is more than one day, enter a value greater than 24hrs. This will automatically convert the 
duration in to the dd,hh:mm:ss format.. 

Tip! 

Adding a duration to a Step segment will cause this segment to dwell at the target setpoint for the configured time period. 

 Configure the Segment type by selecting the setpoint control from the dropdown list. This will define the type of 
control used to attain the next Target Setpoint. 

 STEP will change the operating setpoint to the configured Target Setpoint value at the start of the next 
Segment. 

 DWELL will inherit the setpoint from the previous Segment and retain it at that value for a specified period. 

 RAMPTIME will increase the operating setpoint to a defined Target Setpoint value over a specified time period. 

 RAMPRATE will increase the operating setpoint at a desired rate of change until a defined Target Setpoint 
value is obtained. 

Note 

RAMPRATE is only available for a single channel Setpoint Program. 

 END is read only and signifies the last Segment of the channel. 

Note 

The END segment is read-only and provides an a flag that indicates the end of the Program cycle. It is included in the 
count of the total number of segments in the Program, see PROGCHAN.Monitor.NumSegs in the database. 

 Configure the Target Setpoint by entering the value as a numerical string. This will define the target value that 
an automatic control system will aim to reach. 

 In single channel Programs, configure the Rate parameter for each RampRate Segment. The units are 
determined by the Rate Units configured on the Program page of the Program Properties pane. 

3 In the Program Properties pane, select the Segment tab. 

 Configure a User Values for each Segment in the Program 

 Configure a Exit and/or Wait conditions for each Segment in the Program 

Remember... 

In Single Channel Programs only, also configure a Rate Unit for each Segment on the Program tab 
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Configure a Go Back Sequence 

Configuring a Go Back Sequence can reduce the total number of Segments in the Program. It allows a contiguous set 
of segments to be repeated a specified number of times, as configured in the Go Back Cycles field. 

 

To configure the Go Back Sequence 

1 Select the Segment used to complete the Go Back Sequence in the Segment pane and then show the 
Segment page of the Program Properties pane. 

2 Select the first Segment in the Go Back Sequence in the Go Back To field using the dropdown. 

3 Enter the number of times the Go Back Sequence is to be executed in Go Back Cycles. 

Tip! 

If multiple Go Back Sequences are configured this value must not return to a segment before the previous Go Back 
Sequence. 
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Configure a Holdback 

Holdback provides a means of controlling the duration of a segment if a measured PV (process variable) deviates from 
the SP (setpoint) by more than a configured amount in a specific direction. 

Note 

Holdback can be used to configure a Guaranteed Soak period during a Dwell segment. 

It will extend the duration of all segment types to allow a measured PV to 'catch up' with the SP, or freeze the time 
during a dwell segment. When Holdback is configured to occur during a Dwell segment it is described as a Guaranteed 
Soak period. The Program will remain in Holdback until the measured PV returns to a value within the configured 
Holdback Value. The correct soak period for a product is maintained during the Holdback period. 

Specifically, if at any time during a segment the PV differs from the SP by more than the Holdback Value, in a direction 
specified by Holdback Type, then the program execution engine enters a hold state until the condition no longer 
applies. In this Holdback state, this ramping segment is 'frozen', but ramping segments in other Channels continue. 

To configure a Holdback action 

1 In the Segment pane, select the segment corresponding to the time period at which the Holdback 
needs to be applied. 

2 Select the Channel page on the Program Properties pane to display a section for each Profiled Channel. 

Press the  to maximize the required Profiled Channel section. Other Profiled Channel sections can be minimised by 
pressing the , as appropriate 

Tip! 
The Program Properties pane can be shown or hidden by pressing the button in the centre of the frame dividing it from the 

Chart pane and Segment pane. 

3 Configure how the Holdback mode will be applied. 

 To disable Holdback select Off. Holdback will not be applied if PV deviates from the SP. 

 If the Holdback value is to apply to all segments in the Profiled Channel, select Per Channel. The amount the 
PV is allowed to deviate from the SP is configured in the Holdback + Alarm Value field on the Channel page 
of the Program Properties pane. 

 If the Holdback configuration is to apply to an individual Segment only, select Per Segment. The amount the 
PV is allowed to deviate from the SP is configured in the Holdback + Alarm Value field on the Segment page 

of the Program Properties pane. 

4 Select the Segment tab on the Program Properties pane to display a section for each Profiled Channel that will 
apply the Holdback mode, as configured on the Channel page. 

5 Configure the value for the deviation threshold beyond which holdback is triggered for this setpoint in the Holdback 
+ Alarm Value field on the Channel Page or Segment Page depending on the Holdback mode configuration. 

6 Configure the type of deviation from the SP to cause the Holdback to occur. 

 None will disable Holdback mode in the segment. 

 Low will trigger Holdback mode when the measured PV is below the SP by more than the Holdback value. 

 High will trigger Holdback mode when the measured PV exceeds the SP by more than the Holdback value. 

 Band will trigger Holdback mode when the measured PV is either below (Low) or exceeds (High) the SP by 
more than the Holdback value. 

Note 

A alarm can be delayed using the corresponding Alarm Delay field. Select the field and press the  to reveal a duration 
entry dialog. 

Guaranteed Soak 

This is the same as configuring a Holdback to occur during a Dwell segment, except that the user can define a 
Holdback value for the segment. 
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Configure an Event 

Sometimes at particular times during the operation of the Program it may be necessary to activate external devices. 
These Event fields can be programmed to operate when a segment is executed and will remain on for the duration of 
the segment. 

A different Event can be configured in each segment to control external devices at particular times during the operation 
of the Program. 

 

Note 

When connected to the instrument, any change to Digital Events triggered when the segment is initiated is recorded in the 
Program History. 

To configure an Event 

1 In the Segment pane, select the segment corresponding to the time period at which the Event will occur. 

2 On the Segment page of the 
Program Properties pane, select the 
Event that will be applied when the 
segment is executed corresponding 
to the Event name and select the 
required enumeration from the 
picklist. 

 Off (or user configured 
enumeration, e.g. Stopped) 
can be used to indicate an 
Event will not occur when the 
Segment is executed. 

 On (or user configured 
enumeration, e.g. Running) 
can be used to indicate an 
Event will occur when the 
Segment is executed. 

Remember 

The Program Template file is configured 
using the Programmer Wizard in LINtools. 

This wizard is used to define the Event 
names and enumerations. 
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Configure a User Value 

User Values can be used to write the configured value to an appropriate output in the database when the segment has 
executed. 

A different user defined value in each segment can be wired to a field in the instrument database for use in a particular 
application, e.g. a different output value in each segment can be written to an output by wiring 
PROGCHAN.Monitor.UValn to an output block, typically an AO_UIO block. 

Note 

When connected to the instrument, any User Value written when the segment is initiated is recorded in the Program 
History. 

To configure a User Value 

1 In the Segment pane, select the segment corresponding to the time period at which the User Value 
needs to be written. 

2 On the Segment page of the Program Properties pane, select the User Value that needs to be written to the output 
when the segment is executed corresponding to the User Value name, and then input the required numerical value. 

When a valid value is confirmed, the decimal place notation is determined by the Program Template file. 

 

Remember 

The Program Template file is configured using the Programmer Wizard in LINtools. This wizard is used to define the 
constraints of each User Value. 
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Configure a Wait/Exit condition 

Wait and Exit conditions are used to control the Program in order to ensure specific conditions are achieved before the 
Program can continue or terminate respectively.  

Note 

When connected to the instrument, any Wait/Exit condition applied when the segment is initiated is recorded in the 
Program History. 

A different Wait condition can be configured in each segment to prevent the Program proceeding to the next segment 
until a specific configuration is met. 

A different Exit condition can be configured to terminate the Program when a defined state has occurred in any 
segment that is not ramping the setpoint, i.e. Dwell and Step. This applies to all Channels in a Multi-Channel Program, 
i.e. all Profiled Channels must be running a current Step or Dwell segment. 

Note 

The total number of Wait conditions and Exit conditions is determined by the Program Template file. 

To configure a Wait/Exit condition 

1 In the Segment grid, select the segment corresponding to the time period at which the Wait/Exit 
condition needs to be applied. 

2 On the Segment tab of the Program Properties pane, select the Wait/Exit condition that will be applied when the 
segment is executed corresponding to the Wait/Exit condition name and select the required enumeration from the 
picklist. 

 No Wait/No Exit indicates that a Wait/Exit condition is not applied to this segment. 

 Off (or user configured enumeration) can be used to indicate a Wait/Exit condition will not occur when the 
Segment is executed. The program can continue because it does not rely on a specific configuration to 
continue. 

 On (or user configured enumeration) can be used to indicate a Wait/Exit condition will occur when the 
Segment is executed. The Program is waiting/exiting because a specific configuration is required before it can 
continue. 

 

Remember 
The Program Template file is configured using the Programmer Wizard in LINtools. This wizard is used to define the 

Wait/Exit condition names and enumerations. 
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Control a Program 

This provides runtime control of a Program using the buttons below the Segment pane. 

 

Note 

Only displayed when connected to the instrument. All buttons enabled for clarity. 

Each button causes a configured control action that is applied to the Program currently running in the instrument. 

1 Connect to instrument using Connect command. This will attach to instrument and reveal a number of 
buttons below the Segment pane. 

Note 

The configured segments will not be displayed until the Program is started. 

2 Control the Program using the buttons providing the following commands. 

 

When any button is pressed, a record of the control is added to the Program History. 

Note 

These buttons are internally linked to the PROGCTRL.Monitor.Command subfields in the database. 

START Button 

Used to start the loaded Program from an Idle state. It can also be used to start a Program that is currently in an 
Inhibited State, if this state is first cleared in the database. 

RESTART Button 

Used to restart the loaded Program from a Held state caused by pressing the Hold button. 

HOLD Button 

Used to pause the loaded Program, the remaining time is frozen, and hold the operating setpoint at the current value in 
the currently active Program. This control can only be applied to a currently active Program, or to an running Program 
that is currently in Holdback. 

ABORT Button 

Used to abort the currently active Program. 

RESET Button 

Used to reset the current running Program that has been completed, when End Condition is set to Dwell. This will 
cause the Program to return to the Idle state. 
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SKIP Button 

 

Used to start the next segment from the current operating setpoint, ignoring existing Wait Conditions. 

ADVANCE Button 

 

Used to set the operating setpoint equal to the Target Setpoint and advance to the next segment, ignoring any existing 
Wait Conditions. 

JOG Button 

 

Used to manually change the position in the Program of a current dwell segment by the defined period. 

Pressing this button displays time periods of 1 min, 10 mins and 1 hour for both extending (+), e.g. Program: Running 
(01:34:30 remaining) changes to Program: Running (02:34:30 remaining) if + 1 hour is selected, and reducing (-), 
e.g. Program: Running (01:34:30 remaining) changes to Program: Running (00:34:30 remaining) if - 1 hour is 

selected, the time remaining in the current dwell segment. 

In Multi-Channel Programs, a Jog time will cease when the segment is complete if a Dwell segment runs in parallel to a 
RampTime segment. 

REDO Button 

Used to repeat to the current Dwell or Step segment, when the Program is in a Held state. 

This extends the period of the segment in order to ensure the operating setpoint attains the Target Setpoint. 
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Show the setpoint limits on the Chart 

The Program can be configured to display plots that are 

 extended to the limits configured in the Programmer Wizard, always including 0 (zero) 

 extended to the specific limits configured in the Programmer Editor 

Programmer Wizard 
Plot 

using limits 

Profiled Channel Plot (Y-axis) 

Low Limit High Limit Low Limit High Limit Low Limit High Limit 

-10.000 1500.000  -2.500 1235.000 -2.500 1235.000 

-10.000 1500.000  -2.500 1235.000 -10.000 1500.000 

0.000 1500.000  0.000 1235.000 0.000 1235.000 

0.000 1500.000  0.000 1235.000 0.000 1500.000 

+10.000 1500.000  +12.500 1235.000 +10.000 1235.000 

+10.000 1500.000  +12.500 1235.000 0.000 1500.000 

To change the display of the setpoint limits, 

 Enable ( - checked) the Plot Using Limits command. 

This will cause the Y-axis of each plot to display the limits specified in the Programmer Wizard. 

 

When 'Plot Using Limits' is enabled the plot will always include 0 (zero), as described in the table above. 

 Disable (  - unchecked) the Plot Using Limits command. 

 

This will cause the Y-axis of each plot to display the limits specified in the Programmer Wizard. 
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Configure the Program Template file 

Use the Programmer Wizard 

The Programmer Wizard is used to generate or edit a Program Template file and create a PROG_WIZ compound in the 
database. It will define individual channels that can be profiled alongside digital events and user values The total 
number of digital events and user values is only limited by the size of the .dbf. Additional PROGCHAN blocks are 
automatically created if further digital events and user values are requested. and the maximum number of segments 
available to the Program. 

IMPORTANT NOTE 

The Programmer Wizard creates blocks that can only control Programs produced using this editor. 

 

Note 

Context help will be displayed when the ’r;Help’ check box is set . 

To generate or edit a Program Template file, 

1 Launch the Programmer Wizard. Select Tools > Programmer Wizard. 

2 Progress through the wizard until all appropriate fields are complete, when the Finish button appears. 

3 Press the Finish button to finalise the operation, and automatically generate the PROG_WIZ compound. 

The PROG_WIZ compound contains, 1 PROGCTRL block, up to 8 PROGCHAN blocks one for each profiled channel, 
and up to 8 SEGMENT blocks per channel, providing a maximum of 32 program segments (each SEGMENT block 
offering 4 program segments). 

It will automatically layout the blocks in a logical order. 
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6 Getting specific help 

Open the Help File 

To access this help file, pull down the Help menu and click Contents, Index, or Search. The help file opens with the 

selected option in focus. 

 If already open, the help topic last accessed remains displayed. 

Use the help window’s Contents, Index, or Search tabs to get help on any topic. 

If you want to step from one topic to the next in a logical order, press the browse buttons in the required direction. 
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